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1. Introduction
LeeMail 2.0.6 is a Macintosh mail program which uses the Simple Mail Transfer 

Protocol (SMTP) and the Post Office Protocol (POP) to send and receive mail on a peer-
to-peer basis with Macs, workstations and mainframes. LeeMail requires the use of 
MacTCP or Open Transport, both available from Apple. LeeMail requires System 7 or 
later.

Since LeeMail uses SMTP to transfer mail, LeeMail is ideal for mixed-platform 
environments. LeeMail’s excellent Macintosh interface also makes it ideal for Mac-to-
Mac mail. However, SMTP does not include any store-and-forward capabilities, so your 
Macintosh must be up and running to 



receive mail using that protocol. If your Mac is often turned off, you will probably 
wish to use the POP capabilities in LeeMail.

This manual is meant to both read as a narrative and to provide a handy reference. 
Please read through it quickly at least once, as it may save you some trouble later on.

1.1 Upgrading from version 2.0.4 or earlier
I’ve made every attempt to ensure that version 2.0.6 is completely compatible with 

the settings files of previous versions. However, you may wish to save a copy of the 
LeeMail Settings file before running version 2.0.6.

A bug in the list-handling routines of version 2.0.4 sometimes caused a crash when 
mail was received. Most often this results in another copy being sent by the sending host. 
The partially-received mail is still present in the LeeMail folder, but in an odd state. 
When you open a folder that has such a file, you will see the dialog:

Clicking “OK” in this dialog will convert any partially-received mail files to regular 
LeeMail files so that you can read them within LeeMail. I heartily apologize for any 
problems this bug may have caused!

2. How To Use LeeMail
2.1 Hi!

If you’re anxious to get LeeMail running, go on to section 2.3, QuickStart. If you are
more sedate or are unfamiliar with Mac networking, proceed.

2.2 Running LeeMail the First Time
When you run LeeMail for the first time, it will create a folder called “LeeMail 

Files”, which will contain LeeMail’s preferences and any mail you receive. When 
LeeMail runs subsequent to the first time, it will look for that folder in the same directory
as the LeeMail application, so if you move LeeMail to another folder, move the “LeeMail
Files” folder with it.



The first thing to do is to fill in the LeeMail settings. Choose “Settings” from the 
Edit menu. Each piece of information in the Settings dialog is explained below in Section
2.3. The items marked with asterixes (*) are fields that must be filled in for LeeMail to 
function properly.

2.3 LeeMail Settings
This section defines the various options that can be set in the LeeMail Settings 

dialog. The dialog has a list of groups of options on the left, with the options for the 
selected group on the right, as shown in the figure below.

2.3.1 Mail Setup
* Your Mac’s domain name  This is the domain-name of your Mac. It should be a series 
of names separated by dots; an example is “chs.cusd.claremont.edu”, without the quotes. 
An IP address can also be used, but only if your Mac does not have a domain-name 
assigned to it.

* Your user ID  This can be just about any alphanumeric string; no spaces or punctuation 
should be used. Some examples are “bill”, “laf”, and “John_Doe”. This string is used 
when sending mail and for checking POP mail.

* Your full name  This is your “human” name, which is placed in part the “From” line of 
the mail header so that recipients know who sent them mail. An example is “Lee Fyock”.



* Your address for replies  This is the e-mail address to which people will reply to your 
mail. This address is also placed in the “From” line of the mail header, and it has no real 
correlation to your Macintosh. That is, if your Mac is called “asgard.domain.edu”, you 
could have replies sent to “jack@rpi.edu” by putting that in this field.

* Time Zone or GMT offset  This field is used to generate the “Date” line of the mail 
header. The time zone should be a three-character field, such as “EST” or “GMT”. 
Alternatively, you can use an offset from Greenwich Mean Time, which is expressed as a 
sign (+ or -), followed by four digits. This information can be found in the Map Control 
Panel, if you have set your Mac’s location. For example, in Boston, the GMT offset is 
currently 5 hours, so this field should be set to “-0500”.

2.3.2 Outgoing Mail Options
* Use mail router  This checkbox should be checked if you would like to send all 
outgoing mail through another machine, rather than having LeeMail connect directly to 
the recipient’s machine. This has several benefits. First, sending outgoing mail through a 
machine that is close to you on the network frees up your Mac more quickly than trying 
to connect directly to a machine across the world. Second, if the recipient’s machine is 
not currently accepting mail, you will manually have to instruct LeeMail to try sending 
the mail again, until the mail goes through; if you use a UNIX box as a router, then it will
automatically continue trying to send the mail for three days (more or less; this is settable
by the UNIX system administrator). Third, this may be the only way to get mail to the 
outside Internet, since many companies have security “firewalls” in which only a few 
“trusted” machines are connected both to the outside Internet and the internal networks.

* Router domain name  This is the domain-name of the router to use.

Binhex TEXT enclosures  LeeMail enclosures are sent in binhex format, which is an 
ASCII representation of the Mac file’s resource and data forks. Binhex is widely used on 
the Internet to pass Macintosh files via mail and other mechanisms which prefer ASCII 
data. Text files are normally also binhexed to retain the creator application’s information. 
However, if you are sending a text file to a non-Mac host, you may wish to not binhex it, 
in which case you would uncheck this option. Note that Microsoft Word and other word 
processing documents are not truly “text” documents unless you explicitly save them as 
such.

Limit TCP packet size  LeeMail normally sends data over the TCP/IP stream in blocks 
that are several thousand bytes in length. It has been found in at least one case that a 
TCP/IP gateway had trouble accepting and sending data in these large chunks. When this 
option is checked, LeeMail sends data in 128-byte blocks. This prevents the gateway 
problem, but performance is slowed considerably.



CC to self  When this option is checked, LeeMail keeps a copy of all outgoing mail in a 
folder called “Sent Mail”. Note that enclosures are not copied to the “Sent Mail” folder.

Use XX columns in window  This option allows you to set the number of columns to be 
used in outgoing mail windows. Most mail interfaces provide 80 columns or less for text, 
so it is a good idea to set this value below 80. I recommend between 72 and 76 columns.

Add signature  When this option is checked, LeeMail automatically appends your 
“signature” to the end of your outgoing mail. A person’s signature usually includes the 
person’s name, e-mail address, company, and possibly a witty saying.

Signature…  This button allows you to set the text of the signature to be appended to your
outgoing mail. In keeping with net etiquette (or “netiquette”), the signature is limited to 
400 characters. It is very annoying for people who have slow network connections to read
mail or news posts from people who have 20-line signatures.

2.3.3 Incoming Mail Options
Hide mail headers  When this option is checked, the mail headers are not displayed when
you read a piece of mail. This option can be toggled by holding down the Option key 
when you open the mail.

Show enclosure icons  At the bottom of the mail window, information about the mail is 
shown:  who it is from, the subject of the mail, and the number of enclosures. Optionally, 
if the mail has one or more enclosures, their icons can be shown. When this option is 
checked, the enclosure icons are shown by default.

Scan folders for unread mail  This is a cosmetic feature. When this option is checked, 
folders which contain unread mail appear filled in ( ), much as unread mail items are 
filled in. There is a performance penalty at startup, however, since each folder must be 
checked for unread mail.

Automatically file incoming mail  This is a “multi-user” option which allows several 
users to maintain “accounts” on one Macintosh running LeeMail. Separate users can set 
up different IDs, user names, reply addresses and signatures. When this option is 
checked, incoming mail is filed into separate folders based on the recipient’s user ID. The
folders are created automatically if one does not already exist. See Section 2.10 for more 
information on multi-user operation.

User names…  This button brings up a dialog which allows you to create user accounts, 
with separate user IDs, user names, reply addresses and signatures. These user names 
then appear in the “Send Mail To” dialog as a popup menu. See Section 2.10 for more 
information on multi-user operation.



2.3.4 General Options
Hide windows when in background  When this option is checked, LeeMail hides its 
windows when it is placed in the background. This is handy for keeping LeeMail out of 
the way when you don’t need it.

 except status window  When this option is checked, the Status window is not hidden if 
the “Hide windows” option is checked. This is useful for keeping track of the progress of 
LeeMail’s sending of a large piece of mail in the background.

File only to LeeMail folders  When this option is checked, the “File Mail” command will 
only allow filing to folders in the directory tree under the “LeeMail Files” folder. This is 
a protection to keep novice users from accidentally filing mail into the “Apple Menu 
Items” folder or other possibly inappropriate places. Note that this option will probably 
have to be turned off if you wish to file to aliases of folders outside the “LeeMail Files” 
directory tree.

Enable command-Q for Quit  When this option is checked, the command-key equivalent 
for the Quit command is present. This option can be unchecked to prevent inadvertent 
quitting of LeeMail.

Disable Quit while mailing  This option disables the Quit command while LeeMail is 
sending or receiving mail to prevent loss of mail.

Warn when deleting mail  When this option is checked, LeeMail displays a confirmation 
dialog when deleting mail.

Folders must be empty to delete  When this option is checked, LeeMail will not allow 
folders which contain mail to be deleted. It is strongly recommended that this option be 
checked; if it is not, then you can delete tons of mail with a single keystroke.

Move Deleted Mail to Trash  When this option is checked, deleted mail is moved to the 
Trash. To “undelete” a file, open the Trash icon, select the mail, and choose “Put Away” 
from the File menu in the Finder. It will return to the LeeMail folder from which it was 
deleted. In LeeMail, open that folder, and choose “Update Mail List” to make sure that 
the mail is seen by LeeMail.

Autoquote when replying  When this option is checked, replying to a piece of mail causes 
the mail to be “quoted” or included in your outgoing mail, with each line prepended by 
the quote character defined by the next option.

Use X as the quote character  The X character (filled in by you) is the character used to 
delineate quoted portions of mail. This character (usually “>”) is used both by the 
autoquote function and by the manual Quote menu item function.



2.3.5 Notify Options
Rotate icon while mail arrives  When this option is checked, LeeMail uses the 
Notification Manager to display a small icon over the application menu while mail is 
coming in. This is called “rotation” because of the way the current application’s icon is 
rotated with the icons of applications that have notifications pending. Note that the 
rotating icon means only that mail is arriving, not necessarily that it has been completely 
received.

Play sound when mail arrives  When this option is checked, LeeMail plays a sound 
(selectable also in this set of options) when mail has been received.

Repeat sound until mail read  When this option is checked, LeeMail will continue to play
the mail-arrival sound every so often (settable with the next option) until LeeMail is 
brought to the front. This isn’t really “until the mail is read”, but it is if you read the mail 
when you bring LeeMail to the front. :-)

Repeat sound every XX minutes  This option allows you to set how often LeeMail repeats 
the mail-arrival sound if you have the previous option checked.

Play:  X  This popup menu allows you to choose the sound you wish to have played (if 
that option is checked) when mail arrives. The sounds displayed include the sounds 
installed in your system and the one present in the LeeMail application. The sound 
included with the LeeMail application was sampled using (Caution!  Product plug 
approaching!) my shareware sound editor, Wavicle, and is a sound of a butter knife 
tapping a water glass, for those of you who are insatiably curious.

2.4 QuickStart
Run LeeMail. Choose “Settings” from the “Edit” menu. Fill in the following 

information:
• Your Mac’s domain name
• Your user ID
• Your full name
• Your address for replies
• Time Zone
• Router domain name

At this point, you’re ready to send and receive mail. Have fun!

2.5 Trying Things Out
At this point, you should be ready to send and receive mail!  The easiest way to test 

both operations is to send yourself mail. Do not do this if you are not using a mail router, 
however!  Sending mail to yourself will cause LeeMail to hang (since LeeMail was 
written to do one thing at a time and cannot send and receive mail 



with itself simultaneously). Choose “Send Mail” from the Mail menu. The following
dialog will appear:

Type in your own e-mail address and a subject for the mail and click OK or hit the 
enter key. A window will appear in which you can type your mail. When you are done, 
click the Send button or hit the enter key. The status window should show LeeMail’s 
progress in sending the mail. When the status window shows “Ready”, LeeMail has sent 
the mail. Several seconds later, the status window should indicate that mail is arriving. 
When the mail has been received, a new line will appear in the LeeMail Files window. 
Double-click the line to read your mail.

2.6 General Operation
LeeMail’s main window is called “LeeMail Files”, after the folder which contains 

the LeeMail files (hence the name :-). This window will display a list of sub-folders and 
mail, with the sender, subject and date of arrival for the mail, and may look something 
like the following figure:

This window contains two pieces of mail, and two mail folders. The “Sent Mail” 
folder is created automatically when you use the “CC to self” option. The other folder 
was created using the “New Folder” menu command, and may be used to file mail.

To read a piece of mail or open a mail folder, you may do any of several things:
• Double-click the item
• Single-click the item and choose Open from the File menu ( O)
• Single-click the item and press the Return key
Opening a mail folder brings up a window very similar to the “LeeMail Files” 

window; mail folder windows may also contain mail and/or other folders.

You may note that the window shown above has a header, “From...Subject...Date 
Received”, and an icon ( ). The header titles the columns of information shown for each
piece of mail. You may click the titles to sort the mail by that type of information. The 
icon indicates the sorting direction; click the icon to reverse the sorting direction. In this 
example, the window is sorted by 



Subject, and subjects further in the alphabet are further in the window. More 
information on specifying what information is displayed is given in section 2.7.4, “The 
Mail Menu”.

The columns in the window above may be resized by placing the cursor over the line
to the left of the header, and clicking and dragging the column.  This is easier to do than 
to explain.  :-)  The cursor changes to  when it is placed over a resize hotspot.

2.7 LeeMail Menu Commands
This section explains the use of each LeeMail menu command.

2.7.1 The Apple Menu

The Apple menu contains only the “About LeeMail” item. Choose it to find out 
some information about LeeMail, including information on how to register and pay for it.
:-)

2.7.2 The File Menu contains window- and file-related commands

Open  opens the currently selected mail or folders in a window.

Close  closes the frontmost window, unless it is a dialog.

Save Mail As  saves the currently selected mail (in a folder window) or the contents of the
frontmost window (if you’re reading or composing mail) to a new file.



Append Mail To  saves the currently selected mail (in a folder window) or the contents of 
the frontmost window (if you’re reading or composing mail) to an existing file.

File Mail To Folder  Allows you to file the currently selected mail to a mail folder. If the 
“file only to LeeMail folders” option is checked, then an error will result if you try to file 
the mail outside of the LeeMail Files directory tree. Mail can also be filed to folders by 
selecting and dragging the mail to the folder’s window.

Insert Text File  Allows you to insert the text of an existing file into the text of a message 
you are composing.

Page Setup  Allows you to set the page setup parameters for mail you are reading or 
composing.

Print  Prints the mail you are reading or composing.

Quit  Quits LeeMail.

2.7.3 The Edit Menu contains text editing and LeeMail settings menus.

Undo  undoes the last text-editing action performed in outgoing mail windows.

Cut  deletes the currently selected text and places it in the clipboard.

Copy  copies the currently selected text to the clipboard.

Paste  copies the contents of the clipboard to the frontmost window at the cursor position.

Clear  deletes the currently selected text.



Select All  selects all the text in the frontmost window

Quote  “quotes” the currently selected text by prepending the quote character (defined in 
the Settings dialog) to each line of the selected text.

Aliases  brings up a dialog which allows you to define aliases, or shorthand versions of 
people’s e-mail address or mailing lists.

Settings  brings up a dialog which allows you to tailor LeeMail’s behavior and 
configuration.

2.7.4 The Mail Menu contains mail-related menus.

Send Mail To  brings up a dialog which allows you to specify the e-mail address of the 
recipient and subject of your mail. A window then appears which allows you to type your 
mail, attach enclosures, etc.

Reply  is similar to the Send Mail command in that the same dialog appears, followed by 
the mail-entry window. However, the dialog is pre-filled with the subject and e-mail 
address of the sender of the mail to which you are replying. In addition, if the “autoquote 
when replying” option is checked, the mail to which you are replying is quoted in the text
of your mail.

Forward  also brings up the address dialog, allowing you to specify to whom the mail 
should be forwarded. However, you do not have an opportunity to edit the outgoing mail; 
the mail is forwarded to the recipient immediately.

Delete Mail Item  deletes the currently selected mail (in a mail folder window) or the 
frontmost window (if you’re reading a piece of mail). The operation of the 



delete is tailorable by the “delete only empty folders” and “warn when deleting mail” 
options.

Update Mail List  causes a refresh of the current mail folder window. This may be useful 
if you move mail or mail folders around using the Finder, “behind LeeMail’s back”.

New Mail Folder  creates a new folder in the current mail folder window.

Show Mail Info…  allows you to select what information to display in a mail list window. 
When this menu item is chosen, a dialog appears:

The checkboxes correspond to mail information which may be displayed in mail list 
windows. Select what information you wish to display, and click OK. The frontmost mail 
list window will change to show that information. You may then sort on whatever 
information is displayed. Please note that sorting by Date Sent or Time Sent will probably
not be useful, since differing time zones make sorting a chancy thing. I recommend 
sorting by date or time received, and displaying the date/time sent, if that is desired.

Check POP Server  connects to the POP server (specified in the Settings dialog) and 
retrieves any mail on the server for any of the LeeMail users.

Display Status Window  toggles the display of the status window.

2.8 Reading Mail
To open a piece of mail for reading, follow the instructions under “General 

Operation” above. A window similar to the one shown below will appear.



If the mail you are reading contains enclosures and the “Show enclosure icons” 
option has been checked, then the bottom of the window may contain the icons 
representing the mail’s enclosures, as shown in the following figure:

To view or open an enclosure, double-click the enclosure, or select the enclosure and
then click the “View” button. LeeMail can directly view TEXT, PICT, sound and 
QuickTime movie enclosures. For other enclosures such as Microsoft Word documents or
applications, LeeMail saves the enclosure to the desktop and requests that the Finder 
open the file.

2.9 Sending Mail
To send mail, choose “Send Mail” from the Mail menu. The following dialog will 

appear:

Type the recipient’s e-mail address in the “EMail address” text box and click the 
“To” button. Other recipients may be added as CCs or BCCs. Type the subject of the e-
mail in the Subject box at the bottom of the dialog. Aliases you have defined using the 
“Alias” command under the Edit menu can be used to specify recipients as well. The 
popup menu is used to select the user who is “sending” the mail. This is described further
in Section 2.10, Multi-user Operation.

When you have completed the dialog, click “OK”. A window will appear in which 
you can type the message of your text, similar to the one shown.



Should you wish to change the recipients or subject of the mail, click the “To…” 
button. If you wish to attach documents, applications or other Mac files, click “Enclose”. 
Click “Cancel” to discard the mail, or “OK” to send it.

2.10 Multi-user Operation
LeeMail has several features which lend themselves towards supporting several 

users on one Macintosh:
• Multiple user names, user IDs, reply addresses, and signatures
• Automatic filing of incoming mail to separate users’ folders
• Checking the POP server for all users’ mail
LeeMail defines one “main” user, whose information is defined in the Settings 

dialog:  the user’s name, ID and reply address are set in the “Mail Setup” portion of the 
Settings, while the user’s signature is set in the “Outgoing Mail” portion.

Additional users may be defined in the Settings dialog, under “Incoming Mail 
Options” by checking the “automatically file incoming mail” option and using the “User 
Names” button to enter information into the dialog which appears. When this is done, the 
user names that have been defined appear in the “Send Mail To” dialog in a popup menu 
from which you may choose who the mail is from. If the “Check POP server for mail” 
option is checked, then mail is retrieved from the POP server for each user ID.

3. Using LeeMail for Neat Stuff
• FTP assist  If your Mac is not directly on the Internet, you may have to use another 

machine (a UNIX box) to ftp to sumex and other ftp sites. After you ‘get’ 



several binhexed files to the UNIX machine, you can mail them to your Mac and, 
using LeeMail, very quickly extract the binhexed enclosures. For power users, you can do
a get and mail in the same ftp command:

get coolgame.hqx “|mail me@mymac.domain.edu”
Or, you can mget a bunch of files to the UNIX account and then use something like:

foreach i (*.hqx)
mail me@mymac.domain.edu <$i
end

• Mail Spoofing  Don’t.

4. How to Pay For LeeMail
LeeMail is shareware. This means that you are free to download, copy and give your

friends LeeMail. If you use LeeMail for more than 2 weeks, you are ethically obligated to
pay for it. Without your support, I have little incentive to continue developing or 
enhancing LeeMail.

The shareware pricing for LeeMail is as follows:
1 - 9 users, $25 per user
10 or more users, $20 per user
site license, $1000
worldwide license, $2000

A site license covers all locations for your organization within a 100-mile (160-
kilometer) radius. One advantage of a site license is that you do not need to keep track of 
how many people at your site are using the software.

A worldwide license covers all locations of your organization on this planet.
If you are upgrading from a previous version of LeeMail for which you have paid the

shareware fee, the upgrade is free!
Paying for LeeMail is fairly simple. Open the Register application that came with 

LeeMail and enter your name, email address, and the number of software licenses you 
wish to buy. Save or copy the information from the Register and send it and the payment 
to Kagi Shareware, who handles my payment processing. If paying by credit card or First
Virtual, you may email or fax the information to Kagi. Their email address is 
shareware@kagi.com, and their fax number is +1 510 652-6589.

Payments sent via email are processed within 3 to 4 days. You will receive an email 
acknowledgment when it is processed. Payments sent via fax take up to 10 days, and if 
you provide a valid internet email address, you will receive an email acknowledgment.



If you are paying with cash or USD check, you should print the information using 
the Register application and send it to the address shown on the form, which is:

Kagi Shareware
1442-A Walnut Street #392-LF
Berkeley, CA 94709-1405

You can pay with a wide variety of cash from different countries but at present if you
pay via check, it must be a check drawn in US dollars. Kagi Shareware cannot accept 
checks in other currencies; the conversion rate for non-USD checks is around USD 15 per
check and is therefore not practical.

If you have a purchasing department, you may enter information into the Register 
program and choose “Invoice” as the payment method. Print three copies of the form and 
send it to your accounts payable people. You might want to highlight the line that 
mentions that they must include a copy of the form with their payment. Kagi Shareware 
cannot invoice your company; you must act on my behalf and generate the invoice and 
handle the paperwork on your end.

Payments sent via postal mail need time to reach Kagi Shareware and then up to 10 
days for processing. Again, if you have included a valid email address, you will receive 
an email acknowledgment of processing.

5. Other Documents and Things of Interest
• RFC 821. This Request For Comments defines the Simple Mail Transfer Protocol 

(SMTP). RFCs in general can be highly interesting if you’re interested in how the 
Internet works. These documents can be ftp’d from nic.ddn.mil and other sites.

• RFC 1225. This RFC defines the Post Office Protocol, version 3 (POP3).
• d e v e l o p Issue 6. This issue includes an article and a bunch of excellent TCP/IP

code by Steve Falkenburg. d e v e l o p  in general is an awesome journal 
published quarterly by Apple.

• The latest version of LeeMail (or at least a pointer to its location) is always 
available at <http://chs.cusd.claremont.edu/~fyock>.

6. Troubleshooting
There is one problem that I receive a lot of e-mail about. :-)  There are a couple of 

others that also crop up. The usual question is:
• “Why can I send mail but not receive mail?”

The usual answer is that your Mac’s hostname and IP address is not registered with 
your local nameserver. That means that when someone tries to send you mail, their mailer
attempts to match your e-mail address (of which your domain name is a part) to your IP 
address in order to connect to your Mac to transfer the mail. The sender’s mailer 
therefore connects to your local nameserver and asks for your Mac’s IP address. If your 
nameserver doesn’t have your Mac’s name and IP address registered, the mailer can’t 
send you the mail. The way to fix this is to ask 



your local system administrator (or someone else that knows what’s going on :-) to 
register your Mac.
• “Sometimes the status window shows ‘SMTP Handshaking’, but nothing happens. 

What’s going on?”
Usually, this is caused by a problem that some non-standard mailers have in 

communicating with LeeMail. This has (I believe) been fixed with version 2.0, but if you 
see this problem, drop me a note. Another possible cause is that the connection was being
dropped before handshaking could complete. LeeMail 2.0.4 and later versions have much
longer timeouts, so this should occur very infrequently, if at all.
• “Whenever I run LeeMail, it beeps and exits. What’s going on?”

Your aliases are corrupted for some reason. Trash the “LeeMail Prefs” file, run 
LeeMail, fill in the LeeMail settings, and re-enter the aliases. Or, if you’ve used the 
LeeMail Alias Utility to archive a text copy of your aliases, then use the Utility to rebuild 
the aliases; you don’t have to trash the Prefs file that way. I’ll be adding more robust alias
routines at a later date.
• “The POP stuff doesn’t work. Why?”

The POP support in LeeMail 2.0.6 is somewhat minimal. I’ll be adding more and 
better support in the next major release. If possible, use the “popper” POP3 server, which 
can be ftp’d from ftp.uu.net.
• “I’m using MacPPP 1.x and LeeMail crashes. Why?”

I’m not sure, but MacPPP 2.0 apparently fixes the problem. Upgrade.
• “I’m having trouble getting LeeMail to receive mail over SLIP connections. What 

should I do?”
Some SLIP drivers attempt to dial the modem and make the SLIP connection when a

program tries to open a MacTCP connection. LeeMail only checks to see if the MacTCP 
driver is loaded when LeeMail is launched. If MacTCP isn’t loaded, LeeMail won’t send 
or receive mail. By the time the SLIP driver has the connection open and MacTCP 
loaded, LeeMail has already decided that MacTCP isn’t available. The best work around 
is to launch another MacTCP-using program to open the SLIP connection before you 
launch LeeMail. This won’t be necessary in a future version of LeeMail.



7. Change History
This section is in smaller type to prevent it from eventually dominating the entire document as I add 

more features to LeeMail.

2.0.5-2.0.6 Version 2.0.6 is mainly a feature release. I probably should have bumped it to version 2.1. The changes include:

• URLs are hilited in blue and underlined. Just click on them to open the URL! This requires that Internet Config be 
installed.

• LeeMail uses the Drag Manager now to drag mail between windows. You can also drag mail to the Trash.
• GetURL support; LeeMail can be a helper application for “mailto” URLs.
• You can specify what info to show in mail list windows. You can sort and reverse sort. You can resize the columns. It 

slices, it dices!
• Mail list window information is now cached. You should seldom see the “scanning for mail files” status message now.
• There is now an option for moving deleted mail to the Trash.
• Mail list windows now auto-scroll when dragging mail around in them.
• Mail list windows have color icons now.
• Various misbehaviors when quoting text have been fixed.
• Reading mail windows have more information in them.
• The LeeMail notification sound is now stereo. Very cool.
• LeeMail used to crash if you changed a text field in the Settings, said OK, and tried to do it again. This and other 

miscellaneous bugs have been fixed.

2.0.4-2.0.5 Version 2.0.5 is yet another bug-fix release. The changes include:

• Use separate connections to the POP server, one for each user. Fixes the “I can’t get mail for anyone but the first user” 
problem.

• Wait until mail servers acknowledge LeeMail’s “quit” before closing the connection. This fixes the “my POP mail isn’t
being deleted” problem.

• Don’t encrypt arrow keys or backspace keys into additional users’ passwords. This fixes the “I get POP PASS errors 
for everyone after the first user” problems.

• “Cache” the router’s IP address for multi-recipient mailings. Fixes the “when I send mail to five people through a 
router, it gets sent five times” problem.

• Use WASTE instead of TE32K as the text engine. This gives LeeMail 2.0.5 undo, command-clicking of URLs, and 
drag and drop almost for free. Also provides some international support. Also cleans up a lot of weird behavior with 
scrolling and stuff.

• Make the LDEF more robust. Should reduce crashes quite a bit.
• Display an alert when LeeMail finds files that were “partially received”, probably because of the LDEF crash.
• Rewrite the auto-quoting to work even better.
• Add live scrolling

2.0 3- 2.0.4 Version 2.0.4 is an interim bug-fix release to clean up a few remaining problems while I’m tooling away on 2.1. 
The changes include:

• Rewrote the routines that copy text to a window for reading mail, vastly increasing the speed.
• Changed my e-mail address to “laf@chs.cusd.claremont.edu” in the built-in alias for new users.
• Moved POP checking so that it won’t interfere with transmitting mail.
• Changed the code to store additional users’ POP passwords “encrypted”.
• Increased the timeout for sending and receiving TCP data to 4 minutes (instead of 20 seconds).
• Made some small changes so that received mail windows correctly show the mail Subject even if the From address 

doesn’t contain “@”.
• Fixed a bug in the User Names dialog that didn’t clear the password box when clicking to a user who has no password.
• Fixed a bug which caused a crash when sending mail to people with long user ids (such as 

“bill_the_cat_aka_henderson%some_weird_host_name.more_weird_stuff@host.edu”).
• Fixed a small bug that caused mail list windows to be updated incorrectly when you deleted a piece of mail you were 

reading.
• Worked around some List Manager problems that caused trouble getting to the last item in a mail list window.



2.0.2- 2.0.3 Version 2.0.3 was a yet another bug-fix release mostly to finally clean up the color-QD-on--68000-machines 
problem, and a problem opening connections on Quadras. A few minor features were also incorporated. The changes 
include:

• Use SysEnvirons instead of Gestalt (shudder) to check for color Quickdraw; should eliminate crashes for 68000 users
• “Encrypt” POP passwords -- you'll need to re-enter them. The encryption is very weak (XOR 0xFF), so don't let 

hackers near your Mac. :-)
• List routines massively rewritten to massively increase the number of items which can be displayed in a window (the 

number of pieces of mail which can be stored in a folder should now max out at ~4000, instead of ~400)
• Temporary memory used for almost all windows, so you should be able to open a ton of mail, assuming you have free 

memory in the system heap
• Tabs are now OK in mail headers…
• Think C 5.0.4 generated “odd” code for the CreateStream routine; I've changed the C code so that the compiled code is

correct. 2.0.3 should work with no problem on Quadras…
• There is now some constraint checking on string lengths that you enter, so you shouldn't be able to corrupt your 

settings anymore.

2.0.1- 2.0.2 Version 2.0.2 was a bug-fix release mostly to take care of a problem with System 7 non-Color Quickdraw. A 
few minor features were also incorporated. The changes include:

• Since Gestalt indicates the presence of Color Quickdraw even on non-Color Quickdraw systems, LeeMail 2.0.1 
crashed on a call to NewCWindow for those machines. A work-around is in 2.0.2.

• Multi-line From lines in mail headers are now parsed correctly.
• POP mail is now not requested for a user if the user’s password is blank.
• In previous versions, it was conceivable (though very unlikely) that a file fetched via POP could overwrite one that 

was fetched within the same second that had the same subject. :-)  This is fixed in 2.0.2.
• The text editing routines now line-break correctly for lines that have spaces at the end, at the edge of the window.
• The text editor now handles command-arrow and shift-command-arrow combinations.
• A memory problem which left ~4K of RAM allocated each time the Settings dialog was used has been fixed.
• Various problems with displaying text enclosures have been fixed.
• A problem that caused a crash when the POP server could be found was fixed.
• No attempt is made to fetch POP mail if the MacTCP can’t be opened at startup.
• More strings were placed in resources for ease of translation.

2.0- 2.0.1 Version 2.0.1 was mainly a bug-fix release to clean up a few problems that had slid past the 2.0 testing. A few 
minor features were also incorporated. The changes include:

• LM 2.0 now runs under System 6. This problem was due to a small, embarrassing coding error. :-)  Thanks to Guy 
Brand!

• The “From” popup in the Send dialog now reflects the sender when the “To” button is clicked while composing mail.
• Command-clicking list items in mail windows now acts exactly like shift-clicking.
• Autoquoting does a much better job at wrapping text, particularly if the sender didn’t put returns at the end of each 

line.
• LeeMail will now accept mail from mailers that use bare linefeeds instead of carriage return-linefeed pairs.
• Filing mail to a folder alias works correctly now.
• Deleting an alias now selects the first remaining alias.
• The timeout period was increased to allow for slow networks.
• All strings (or almost all) were placed in resources for ease of translation. More thanks to Guy Brand!
• POP error reporting is now done through the status window to facilitate unattended operation.


